Information and Communication technology 1

Vladimír Jehlička
This material was created under the project „Inovation of subjects of study in Fakulty of Education at Univerzity of Hradec Králové“, reg. num. CZ.1.07/2.2.00/28.0036.
Basic information

Teacher: Ing. Karol Radocha, Ph.D.

Contact: Karol.Radocha@uhk.cz

The number of hours of direct education: 0 hours

The number of hours of self-study: 14 hours

The inclusion of the course: 1. semester

Syllabus

The course is based on the project European Computer Driving Licence (ECDL).

- Concepts of information and communication technology (ICT).
- Using the computer and managing files.
- Word processing.
- Web browsing and communication.
Icons in the text

- **Objectives**
  At the beginning of each chapter is a list of objectives.

- **Time required**
  Indicates approximately how much time you need for studying the chapter.

- **The terms to remember**
  A list of important terms and the main points that the student in the study of the topic should not miss.

- **Note**
  In the note are various less important or clarifying informations.

- **Control questions**
  Examine to what extent the student understand the text and problems, memorizing relevant and important information.

- **Summary**
  Summary of topic.

- **Literature**
  Used in the study material to complement and extend the findings.
Content
1  Concepts of information and communication technology (ICT) ........................................... 8
   1.1  Hardware .......................................................................................................................... 8
       1.1.1  Basic concepts .......................................................................................................... 8
       1.1.2  Computer performance ......................................................................................... 9
       1.1.3  Memory and storage of data .................................................................................. 10
       1.1.4  Input and output device ......................................................................................... 11
   1.2  Software ............................................................................................................................ 12
       1.2.1  Basic concepts .......................................................................................................... 12
       1.2.2  Principle of work on computer .............................................................................. 12
   1.3  Computer networks ........................................................................................................... 13
       1.3.1  Types of computer networks ................................................................................. 13
       1.3.2  Data transfer ........................................................................................................... 13
   1.4  ICT (Information and Communication technology) ..................................................... 14
       1.4.1  Using of computers .................................................................................................. 14
       1.4.2  Communication ......................................................................................................... 15
       1.4.3  Virtual communities ............................................................................................... 16
       1.4.4  Hygiene and work protection .................................................................................. 16
       1.4.5  Environment ............................................................................................................ 17
   1.5  Information systems protection ....................................................................................... 17
       1.5.1  Data .......................................................................................................................... 17
       1.5.2  Software ................................................................................................................... 18
       1.5.3  Hardware ................................................................................................................ 18
   1.6  Law ..................................................................................................................................... 19
       1.6.1  Copyright law ........................................................................................................... 19
       1.6.2  Protection of persona data ....................................................................................... 19

2  Using the Computer and Managing Files ............................................................................ 20
   2.1  Operating system .............................................................................................................. 20
       2.1.1  First steps ................................................................................................................ 20
       2.1.2  How to set some computer parameters .................................................................. 23
       2.1.3  Work with icons ....................................................................................................... 37
       2.1.4  Window ..................................................................................................................... 38
   2.2  How to work with files and folders .................................................................................. 40
       2.2.1  Basic concepts .......................................................................................................... 40
       2.2.2  Files and folders ....................................................................................................... 44
       2.2.3  Work with files ........................................................................................................ 47
       2.2.4  How to move and copy objects .............................................................................. 55
       2.2.5  Deleting and restoration ......................................................................................... 60
       2.2.6  How to search for files and folders ....................................................................... 63
   2.3  Assistance programs ......................................................................................................... 64
       2.3.1  File compression ....................................................................................................... 64
       2.3.2  Antivirus program .................................................................................................... 67
   2.4  Print management ............................................................................................................ 69
       2.4.1  How to set different default printers ..................................................................... 69
       2.4.2  How to print files from the Computer ................................................................. 71

3  Word Processing .................................................................................................................... 73
   3.1  The main use of Microsoft Word text editor ................................................................. 73
       3.1.1  Working with documents ...................................................................................... 74
       3.1.2  Improve work efficiency ....................................................................................... 78
3.2 Creating a text document ................................................................. 84
3.2.1 Entering text............................................................................. 84
3.2.2 Selecting and editing................................................................. 87
3.3 Formatting text ............................................................................. 91
3.3.1 Text ......................................................................................... 91
3.3.2 Paragraph .............................................................................. 96
3.4 Objects.......................................................................................... 102
3.4.1 Tables ...................................................................................... 102
3.4.2 Formatting of tables ................................................................. 104
3.4.3 Graphic objects ..................................................................... 108
3.5 Mail merge .................................................................................. 111
3.5.1 Preparation ........................................................................... 111
3.5.2 Outputs ................................................................................ 119
3.6 Preparation of printouts ............................................................... 120
3.6.1 Setting .................................................................................. 120
3.6.2 Revision and print ................................................................. 126
4 Web Browsing and Communication ............................................. 130
4.1 Internet ....................................................................................... 131
4.1.1 Basic concepts....................................................................... 131
4.1.2 Safety aspects......................................................................... 131
4.2 Web browser Internet Explorer ................................................ 132
4.2.1 Basic viewing ......................................................................... 132
4.2.2 Setting ................................................................................... 134
4.2.3 Navigation ............................................................................. 135
4.3 Working with the Internet ........................................................... 136
4.3.1 Forms ................................................................................... 136
4.3.2 Searching ............................................................................. 137
4.4 Outputs from the Internet ............................................................ 138
4.4.1 Saving files ........................................................................... 138
4.4.2 Preparation and printing ....................................................... 139
4.5 Elektronic kommunikation ........................................................... 142
4.5.1 Basic concepts....................................................................... 142
4.5.2 Safety aspects....................................................................... 143
4.5.3 Theory .................................................................................. 143
4.6 Using e-mail ............................................................................... 144
4.6.1 Sending a new message ....................................................... 144
4.6.2 Reading the message ............................................................. 148
4.6.3 Improving the efficiency of work ....................................... 150
4.7 Management of e-mails ............................................................... 151
4.7.1 Organizations ....................................................................... 151
5 Dictionary of important terms ....................................................... 155
The terms to remember

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Importance of abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD</td>
<td>Compact Disc</td>
</tr>
<tr>
<td>CD-R</td>
<td>Compact Disc – Recordable</td>
</tr>
<tr>
<td>CD-RW</td>
<td>Compact Disc – ReWritable</td>
</tr>
<tr>
<td>CPU</td>
<td>Central Processing Unit</td>
</tr>
<tr>
<td>DVD</td>
<td>Digital Versatile Disc; Digital Video Disc</td>
</tr>
<tr>
<td>DVD-R</td>
<td>Digital Versatile Disc – Recordable</td>
</tr>
<tr>
<td>DVD-RW</td>
<td>Digital Versatile Disc – ReWritable</td>
</tr>
<tr>
<td>ECDL</td>
<td>European Computer Driving Licence</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>ICT</td>
<td>Information and Communication Technologies</td>
</tr>
<tr>
<td>IM</td>
<td>Instant Messaging</td>
</tr>
<tr>
<td>LAN</td>
<td>Local Area Network</td>
</tr>
<tr>
<td>MOODLE</td>
<td>Modular Object-Oriented Dynamic Learning Environment</td>
</tr>
<tr>
<td>MS</td>
<td>Microsoft</td>
</tr>
<tr>
<td>MS DOS</td>
<td>Microsoft Disc Operating System</td>
</tr>
<tr>
<td>PC</td>
<td>Personal Computer</td>
</tr>
<tr>
<td>PDA</td>
<td>Personal Digital Assistant</td>
</tr>
<tr>
<td>RAID</td>
<td>Redundant Array of Inexpensive/Independent Disks</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory</td>
</tr>
<tr>
<td>ROM</td>
<td>Read Only Memory</td>
</tr>
<tr>
<td>RSS</td>
<td>Really Simple Syndication feed</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>VDU</td>
<td>Video Display Unit</td>
</tr>
<tr>
<td>VoIP</td>
<td>Voice over Internet Protocol</td>
</tr>
<tr>
<td>VPN</td>
<td>Virtual Private Network</td>
</tr>
<tr>
<td>WAN</td>
<td>Wide Area Network</td>
</tr>
<tr>
<td>WLAN</td>
<td>Wireless Local Area Network</td>
</tr>
<tr>
<td>WWW</td>
<td>World Wide Web</td>
</tr>
</tbody>
</table>
1 Concepts of information and communication technology (ICT)

Objectives (ECDL Module 1)
Concepts of Information and Communication Technology (ICT) requires the candidate to understand the main concepts of ICT at a general level, and to know about the different parts of a computer.
The candidate shall be able to:

- Understand what hardware is, know about factors that affect computer performance and know about peripheral devices.
- Understand what software is and give examples of common applications software and operating system software.
- Understand how information networks are used within computing, and be aware of the different options to connect to the Internet.
- Understand what Information and Communication Technology (ICT) is and give examples of its practical applications in everyday life.
- Understand health and safety and environmental issues in relation to using computers.
- Recognize important security issues associated with using computers.
- Recognize important legal issues in relation to copyright and data protection associated with using computers.

Time required
2 hours of basic studies and individually more time to practice.

The terms to remember
- hardware
- processor
- memory
- input device
- output device
- software
- operating system
- application system
- computer networks
- internet
- e-learning
- health
- computer virus
- data protection
- personal data

1.1 Hardware
Material fittings.

1.1.1 Basic concepts
Computer
- PC (Personal Computer)
- Tablet PC
• PDA (Personal Digital Assistant)
• Mobile computer
  o notebook,
  o laptop,
  o palmtop,
  o tablet,
  o smartphone.
• Multimedia: word processing, graphic, sound, video on computer, exploitation: games, education, presentation, business application.
• Intelligent terminal: can takes some work from main computer.
• Not intelligent terminal: access only to main computer.
• Computers for special application: industry, transport, communication.

The main part of the computer
• Case
  o tower, minitower, desktop,
  o main switch,
  o button Reset,
  o mechanics,
  o diodes,
  o green diode – computer turned on,
  o red diode – work with hard disk.
• Motherboard.
• Processor - CPU (Central Processing Unit). Company Intel (processor Pentium oc Celeron), AMD (processor Athlon), Cyrik. Today Intel Pentium 2.6 GHz. Executive part, making program command, calculation, logical operation.
• RAM (Random Access Memory). Today 512 MB. Operating (primary working) memory for reading and writing, random access from processor. If computer turn off – the content memory delete.
• ROM (Read Only Memory). Hard copy – basic programs.
• Hard disk. Internal or external, today 256 GB, memory with permanent record, magnetic record.
• Graphics card. Display monitor.
• Sound card. Signal for speakers
• Net card. Connection computer to net.
• Serial port. Connector for connected to periphery, modem and mouse (COM1 and COM2).
• Parallel port. Connector for connection to periphery, printer, scanner, external mechanics (CD, DVD, ZIP, hard disk).
• Peripheral device. Input, output and in-out devices.

1.1.2 Computer performance

Computer performance and capacity depended on
• Type processor
• Speed processor (MHz)
• Size RAM
• Buffer size
- Speed and capacity harddisk
- Bus speed
- Quantity running programs

1.1.3 Memory and storage of data

Types of computer memory
- RAM (Random Access Memory).
- ROM (Read Only Memory).

Capacity of memory
- Bits (symbol b)
  Basic unit for measurement memory of computer. Matches one cell – 0 or 1.
- Bytes (symbol B)
  - 1 B (byte) = 8 bits, storage one symbol,
  - 1 kB (kilo byte) = 1 000 B, \(2^{10}\) B = 1 024 B,
  - 1 MB (mega byte) = 1 000 kB, \(2^{10}\) kB = 1 024 kB,
  - 1 GB (giga byte) = 1 000 MB, \(2^{10}\) MB = 1 024 MB,
  - 1 TB (tera byte) = 1 000 GB, \(2^{10}\) GB = 1 024 GB.

Data storage media (all recording devices are used for continuous data recording with write and read data).
- HDD (HDD – Hard Disk Drive): rewritable, capacity 100 GB až 4 TB.
- Floppy disk: rewritable, capacity 1,44 MB (archaic).
- Zip disk: rewritable, capacity 100 MB or 250 MB (archaic).
- CD-R (Compact Disc – Recordable): permanent record of the data on the disk is used only for one-time data entry. Disk with a diameter of 12 cm has 700 MB capacity, disk with a diameter of 8 cm has a capacity 210 MB.
- CD-RW (Compact Disc – ReWritable): permanent record of the data on the disk, rewritable, capacity is the same as by CD-R.
- DVD-R (Digital Versatile Disc – Recordable): permanent record of the data on the disk, capacity 4,7 GB. The disk is used only for one-time data entry.
- DVD-RW (Digital Versatile Disc – ReWritable): permanent record of the data on the disk, rewritable, capacity 4,7 GB.
- USB Flash disk (Universal Serial Bus): rewritable, capacity 2 GB to 512 GB.
- External hard disk: rewritable, capacity 500 GB to 2 TB.
- RAID (Redundant Array of Inexpensive/Independent Disks): write to the field of independent rewritable discs.
- The network disk: Usually more rewritable discs that are within a computer network accessible to users from their computers to connect to the network.
- Web disk: Backup data on a system of independent rewritable discs or rewritable tape drives that are connected to a network.
- Memory card: a rewritable replacement hard drive for portable devices such as camera, video camera, etc.. Capacity 2 GB to 64 GB.
1.1.4 Input and output device

Input device
- keyboard,
- mouse: mechanics or optical set-up for show, choice, inserting with two buton. Between buton can be circlelet for text drift,
- trackball: mouse in netobook, wafer,
- touchpad,
- joystick: control arrow on screen by per with handle – computer games,
- mechanics for CD-ROM (Compact Disk – Read Only Memory): stabile record data with capacity 650 or 700 MB,
- mechanics for DVD-ROM: stabile record data with capacity 4,7 GB,
- tablet,
- light pen: computer control,
- some reader for example barcode, cards, Brail’s writing,
- microphone,
- scanner: scan graphical a text model,
- digital foto,
- digital camera,
- mesuring instruments with any analog-digital converters etc.

Output device
- monitor (VDU – Video Display Unit), SCD monitors,
- printer
  - dot printer – inked ribbon, most often 24 dots (blackwhite, no qualite but cheap costs),
  - ink printer – drop of ink (blackwhite or coloured printing, low purchase price, high operational costs, high quality printing),
  - laser printer – toner smelted on paper (blackwhite or coloured printing, high purchase price, low operational costs, most quality printing),
- net printers: access from more computers in computer network,
- plottr: (drawing by per with black or colour filing), usage for technical plans,
- headphones or speaker,
- vocal synthesizer,
- dataprojector,
- large screens,
- action parts with digital-analogical invertors.

Input-output devices
- touch screen (computer control),
- USB flash disk,
- mechanics for CD-RWM (Compact Disk – Read Write Memory): stabile record data, read and write data,
- modem – connects compute to telephone line, internal (in computer), external (in box),
- magnetic backup units: memory media with stabile data record (data box),
- external harddisk,
1.2 Software

Nonmaterial fittings.

1.2.1 Basic concepts

Operation systems

- Basic program for drive computer, DOS – Disk Operating System, Microsoft Windows (MS Windows), operation system Mac NT4, Linux, Unix, Novell.

User Interface

- Text: MS DOS, Unix systems,
- GUI (Graphical User Interface): MS Windows, Linux: simple interaction with computer.

Programs and applications

- For example MS Word – writing text,
- MS Excel – calculations in table and production graph,
- Painting – Drawing,
- PowerPoint – creation presentations,
- Internet Explorer – browsing www pages on Internet,
- Outlook – sending mail, MS Access – creation databases,
- multimedia application,
- database and economical systems,
- and others.

Dokumets

- All records of informations in computer (letter, picture, sound, video, …)

Folders or directories

- Space for saving other subfolders and files (tree structure components, root, folder, master folder, subfolder).

1.2.2 Principle of work on computer

Description of the basic cycle

- into RAM are loaded data e.g. from harddisk,
- CPU processes data in RAM,
- data from the RAM is saved for example to your harddisk,
- the cycle is repeated.
- Attention: data that has been stored in RAM, for example on the hard disk, will be deleted after the computer shuts down.
1.3 Computer networks

1.3.1 Types of computer networks

Basic types of computer networks

- **LAN** (Local Area Network): one building, one organization (don't control computer – server, single station – clients, cabling, active element), access to net.
- **WLAN** (Wireless Local Area Network)
- **WAN** (Wide Area Network): more locations (more states, all world): phone and other special connection.
- **PSDN** (Public Switched Data Network): public data net.
- **ISDN** (Integrated Service Digital Network): standard for send digital phone and data service.
- **Internet**: global area network.
- **Intranet**
- **VPN** (Virtual private Network)

Connecting computers type client / server

- **Client**: user's computer that is used to enter data into the system and to read data from the system. The system (e.g. some database) is a managed by server.
- **Server**: computer that manages the system.

Internet / intranet

- **Internet**: global area networks.
- **Intranet**: closed computer network.
- **VPN** (Virtual Private Network).

1.3.2 Data transfer

Basic concepts

- **Download**: download data from the network to the user's computer.
- **Upload**: load data from a user's computer to a network.

Transmission speed

Expresses the amount of information that is transmitted per unit of time. It is given in the following units:

- binary bits per second (b/s),
- binary kilobits per second (Kb/s),
- binary megabits per second (Mb/s).

**Internet** – global area network

- **Services net**
  - **WWW** (World Wide Web): worldwide multimedia information structure connected by links. Requires installation program: browser Microsoft Internet Explorer, Netscape Navigator, …,
  - **e-mail**,
  - **transmission files**,
- discussion groups.

- **Time of connection**
  - www – connection for work,
  - e-mail – automatic connection only in time receiving and sending messages.

- **Grafical user interface**: using mouse.

- **Hypertext links – nonlinear text**: links to other pages.

- **Search engine**: programs, which are searching informations in database: Google, Seznam, Atlas, Najdito, Centrum, Altavista, Yahoo, Hotbot, Lycos, Exite, WebCrawler.

- **Usage Internet**: search information, research, marketing, shopping.

**Connected to computer set, Internet and e-mail**

- **Technical resources for connect**
  - set card and hard connected with set,
  - or modem and connection by telephone link,
  - software for e-mail (Microsoft Outlook), for searching web space, telecommunication software.

- **ISP** (Internet Service Provider).

- **Broadband** internet access.

- **ADSL** (Asymmetric Digital Subscriber Line).

- **Wi-Fi** (Wireless Fidelity).

- **Satelit connect**.

**Work group**

- Computer with net adapter, net operating system, cables, server and connection to network.

1.4 **ICT (Information and Communication technology)**

1.4.1 **Using of computers**

**Home**

- Text editor,
- spreadsheet processor,
- painting,
- presentation,
- e-mail,
- web browser,
- database and book-keeping programs,
- computer games,
- work from home,
- projects,
- homework.

**Office, civil service**

- Text editor,
• spreadsheet processor,
• e-mail,
• web browser,
• database and book-keeping programs,
• information systems.

**Education**
• CBT (Computer Based Training),
• multimedial education programs,
• e-learning,
• Internet,
• e-mail,
• simulation and modeling tools.

**Industry**
• Projecting on computer – CAD (Computer Aided Design), manufacturing line control, processes minimisation and aim maximisation,
• MIS (Management Information Systems),
• EIS (Executive Information Systems),
• CAM (Computer Aided Manufacturing).

**Traffic**
• Cards driving,
• aircrafts,
• traffic control (air, metro, railway).

**Bussines**
• Stock detail,
• electronic data interchange – automatic orders,
• reservation tickets,
• accounting,
• credit cards,
• electronic cash desk in shops,
• cash dispensers.

**Hotel**
• Standard office applications,
• presentations,
• on-line reservation system,
• telephone call registration,
• food reservation.

1.4.2 **Communication**
• E-mail
  • advantages: fast and cheap delivering post to any place in the world, address list, setup for effective post processing post, cooperation to exchangeunets,
• **disadvantages**: virus diffusion, congestion post, spam.

- IM (Instant Messaging)
- VoIP (Voice over Internet Protocol)
- RSS (Really Simple Syndication feed)
- Web log
- Podcast

### 1.4.3 Virtual communities

**Online (virtual) community**

- websites of interest groups,
- internet forums,
- chat room,
- community players online games.

**Publication and sharing of information in real time**

- web log (blog),
- podcast,
- internet photo albums,
- archives of sound recordings,
- archives of video clips

**Preventive actions in communication with a virtual community**

- create a personal private profile,
- limit the amount of disclosed personal information,
- availability of published information,
- avoiding of unknown.

### 1.4.4 Hygiene and work protection

**Danger**

- eyestrain, visual impediment,
- damage to nerve fibers in the hands of, pain-shoulders, elbow, crpus,
- headache,
- rachialgia – ergonomics, back pain,
- exhaustion general, overloading.

**Health provision and ergonomics demands**

- interval at work with computer,
- right layer of screens,
- angle on screens,
- distance on screens,
- right lighting,
- jalousie,
- right hight desk,
- right distance from desk,
• foot well,
• variable chair,
• angle block,
• ergonomics keybouard,
• right location of mouse,
• ventilation,
• workplace.

Work protection
• work with electric machines,
• safe hardware,
• safe service cable,
• not overloading electric net.

1.4.5 Environment

Recyklng
• computer components,
• printer cartirdges,
• paper.

Saving energy when using your computer
• automatic switch off the monitor,
• automatic suspend and shutdown the computer.

1.5 Information systems protection

1.5.1 Data

Data protection act: office of data security
• legal data collection,
• exactly specification purpose collection,
• exact terms limitation time for data holding,
• data security,
• access persons to their personal dates.

Personal dates
• employer police,
• army,
• doctor,
• bank,
• insurance office,
• revenue authority,
• welfare centre,
• municipality,
• sanitation.
Security

- Security against unauthorized access to informations,
- security against misuse, demane or destruction datas,
- security against heckers
- physical security computer and nonavailability informations,
- unauthorized access: usage passwords for all computer, for connect to net, for software or for files,
- data encryption,
- setting disk only for reading,
- periodic archivin (systém backup): for Exchange memory media, for server, archiving total, step, local, interval-archiving (large firm – every day, small firm – once a week),
- security computer against power supply failure: using UPS, filter, periodic archiving data periodic total archiving systém,
- computer virus (harmful program): diffusion virus, antivirus programs,
- kinds of computer virus:
  - harmless – displayed some picture or text on the screen,
  - destructive – destruction part of saved files,
  - reconnaissance – enabled unauthorized access over passsword,
  - macrovirus – doesn´t limpt programs but documents,
- diffusion viruses: disks, CD-R, e-mail, unknown files,
- security against virus
  - periodic using antivirus programs for control all files and e-mail,
  - control disks,
  - period renewal antivirus programs,
  - control set downloads from net,
  - liquidation programs unknown origin,
  - unable using macros in programs.

1.5.2 Software

- Firewall
- Copyright – software user´s licence.
- Kinds of software
  - commerce software – advance, user´s licence,
  - multilicence – discount for some organisations,
  - shareware – „first try then pay“, free for 30days,
  - freeware – freely moderate programs,
  - public domain freely moderate with source code.

1.5.3 Hardware

- Reserve source electric current – bateries.
- Infrafragible flow: UPS (Uninterrupted Power Supply) – combination bateries and software,
- voltage regulator tube,
- over-voltage tube,
- care of computer
  - ensure: good cooling, clean environment, no shock, independent electric
source,
  o despatch: dust, dampness, food and drink, high temperature, remove running computer, switching without escape programs, shroud ventilating aperature, site disks near magnetic fields,
  • rectifiable defects: wrong cable given to computer, periphery, power points, computer net disconnected power points.

1.6 Law

1.6.1 Copyright law

Licensed software
  • check the identification numbers,
  • control product registration,
  • license agreement,
  • end-user license agreement.

1.6.2 Protection of personal data
  • Allocation of responsibility to the administrator of personal data,
  • Law on the protection of personal data,
  • The main duties of the administrator of personal data in the Czech Republic.
2 Using the Computer and Managing Files

Objectives (ECDL Module 2)
Using the Computer and Managing Files requires the candidate to demonstrate competence in running and managing a personal computer. The candidate shall be able to:

- Use the main features of the operating system including adjusting the main computer settings and using built-in help features.
- Operate effectively around the computer desktop and work effectively in a graphical user environment.
- Know about the main concepts of file management and be able to efficiently organize files and folders so that they are easy to identify and find.
- Use utility software to compress and extract large files and use anti-virus software to protect against computer viruses.
- Demonstrate the ability to use simple text editing and print tools available within the operating system.

Time required
2 hours of basic studies and individually more time to practice.

The terms to remember
- operating system
- desktop
- window
- icons
- toolbar
- component
- tree structure
- file
- file attribute
- waste bin
- compression
- extraction
- antivirus program
- virus database
- installing the printer

2.1 Operating system

2.1.1 First steps

Starting computer
Confirm that the computer is connected to the power supply, turn the monitor with a monitor power switch (in some cases the monitor is turned on automatically together with the computer), turn the computer by using computer's main switch, wait for the computer to boot an operating system, for tests to pass and icons to be displayed on the screen of the Windows environment.

Important concepts
- Icon: a simple image generally attached with a brief description. It is used for
fast controlling of the computer.

- **Desktop**: main screen that contains icons and the Main panel with the **Start**.
- **Main panel**: it is located on the bottom of the screen and serves for launching applications, for accessing open files and running applications etc.
- **Application**: program.
- **Mouse**: pointing device (1.7.13). If not said otherwise which mouse button is to be pressed, we will consider the left button on the standard right-handed mouse. The pressing of the right button will be noted.
- **Mouse cursor**: it is generally an arrow on the screen. By moving the mouse device we control movement of the cursor on the screen.
- **To point at an object**: we move the arrow of the mouse cursor on the particular place (object) on the screen.
- **To click on an object**: an object is an icon, a button, a file etc. We point at the object and shortly press and release once the left mouse button without moving the mouse over the mousepad.
- **To double-click on an object**: we click twice on the object.
- **To drag and drop an object**: we point at moved object, press the left mouse button (and keep pressed), by moving the mouse over the mousepad move the mouse cursor over the screen and by doing that move the object itself. When we release the button the object is moved to new location.
- **Window**: defined area of the computer screen in the shape of a rectangle. In the window opens and displays the running application.
- **Desktop**: the entire area of the screen (monitor) of the computer on which they are displayed information in graphical and textual form.
- **Command line**: line on the bottom edge of the desktop.

**How to restart the computer**

Klick on icon → [Restartovat] → [Vypnout] →

Or press the key Ctrl+Alt+Delete combination.

**How to finish working with an application**

Main menu: **File → Exit** or closing a window by clicking on the button [X].

**How to shut down the computer**

Finish working with all running applications. Then perform → [Vypnout].
**Help browsing**

In a launched application we select (by clicking on the item) the item **Help** (shortly: menu bar → **Help**, click on the key [F1]).

In displayed dialog window we selecting help by clicking on the selected text.
2.1.2 How to set some computer parameters

How to determine computer configuration

In the displayed window double-click on the icon **Systém**. The window containing tabs with basic information about the computer's system is displayed (operating system, processor type, amount of the RAM memory…).
Základní informace o počítači

Verze systému Windows
Windows 7 Enterprise
Copyright © 2009 Microsoft Corporation. Všechna práva vyhrazena.
Service Pack 1

Systém

Hodnocení: Sladěně uživatelského zkušenosti se systémem Windows

Procesor: Intel® Core™ i7-2600 CPU @ 3.40GHz, 2.00 GHz

Nainstalovaná paměť (RAM): 8,00 GB

Typ systému: 32bitový operační systém

Pár s dotykové ovládání: Pro tento displej nemá disponovat ani dotykové ovládání.

Název počítače, domena a nastavení pracovní skupiny

Název počítače: jablička-ntb
Úplný název počítače: jablička-ntb
Popis počítače: 
Pracovní skupina: WORKGROUP

Aktivační systému Windows

Systém Windows je aktivován.
ID produktu: 59J1-008-1312563-6695
Změnit kód Product Key

Další informace online...
How to set time and date

1. Click on the icon Ovládací panely.
2. Double-click on the icon Datum a čas.

The window is displayed.

Double-click on the icon Datum a čas...
The window is displayed.
How to display screen properties

Double-click on the icon "Pozadí plochy".
Double-click on the icon **Barva okén**.
Double-click on the icon Zvuk. The window is displayed.

Click on the Přehrávání.
Double-click on the Reproduktory. The window is displayed.
Click on the **Urovně**.
The speaker volume can also be changed so that in the command line on the desktop, we click on the icon 🎧. In displayed panel we use the slider 🔊 to set the volume of the speakers.
Double-click on the icon "Spoji obrazovky". The window is displayed.
How to set screen resolution

![Image of screen resolution settings]

Click on the **Upravit rozlišení**.
How to set Czech or English mode

The window is displayed.

Click on the...
How to switch a keyboard to the English mode

On the main panel click on the button [CS] and from displayed menu select [EN] item

How to switch a keyboard to the Czech mode

Main panel → button [EN] → [CZ].
### 2.1.3 Work with icons

<table>
<thead>
<tr>
<th>Icons</th>
<th>Meaning of icons</th>
</tr>
</thead>
<tbody>
<tr>
<td>📁 Místní disk (C:)</td>
<td>Hard disk C</td>
</tr>
<tr>
<td>💻 HS100 (F:)</td>
<td>External disk</td>
</tr>
<tr>
<td>📯</td>
<td>Folder with files</td>
</tr>
<tr>
<td>📄</td>
<td>File with test (MS Word)</td>
</tr>
<tr>
<td>📄</td>
<td>File with database (MS Access)</td>
</tr>
<tr>
<td>📄</td>
<td>File in PDF format (Adobe Reader)</td>
</tr>
<tr>
<td>📄</td>
<td>Application MS Word</td>
</tr>
<tr>
<td>📄</td>
<td>Application Adobe Reader</td>
</tr>
<tr>
<td>📄</td>
<td>Application Malování</td>
</tr>
<tr>
<td>📄</td>
<td>Application MS Word</td>
</tr>
<tr>
<td>📄</td>
<td>Application MS Excel</td>
</tr>
<tr>
<td>📄</td>
<td>Application MS PowerPoint</td>
</tr>
<tr>
<td>📄</td>
<td>Application MS Outlook</td>
</tr>
<tr>
<td>📄</td>
<td>Printer</td>
</tr>
<tr>
<td>📄</td>
<td>Waste bin</td>
</tr>
</tbody>
</table>

#### Moving your icons on the desktop
- click on icon,
- move the cursor over the desktop while holding the left mouse button,
- release the left mouse button.
2.1.4 Window

Window title
First line of the window containing a name of the application (program) and buttons for controlling the window.

Menu bar (main menu)

When we click on the selected item (e.g. ), the related submenu will be displayed.

The tab is used for
- saving and closing files,
- open a new file,
- print file,
- finish working with an application.
**Tabs**

Lines with image buttons (icons) used for quick operating the application, e.g. for MS Word.

**Tools panels**

**Status line**

The last line of the window.

**Scroll-bar**

A horizontal or vertical scroll-bar for displaying objects that are too large to fit in the screen area.
The actual location of displayed object inside of the screen can be controlled by scrolling the bar

or by clicking on an arrow button on the bar

**To minimize a window**
In a window title we click on the button (the window still running).

**To maximize a window**
In a window title we click on the button .

**To restore default window's size**
In a window title we click on the button .

**To resize window's size**
- we point the cursor at an edge of the window that isn't maximized (the cursor changes into horizontal or vertical both-sided arrow),
- we hold pressed left mouse button and moving the mouse (by doing that the size of the window is changing),
- we release the pressed button.

**To move a window**
We point the mouse cursor at the window title, press left mouse button, move the window to a new location on the screen and release pressed mouse button

**To close a window (ends/exits the application)**
In a window title we click on the button x.

### 2.2 How to work with files and folders

#### 2.2.1 Basic concepts

**Tree direktory structure**
- Computer
- Folder (direktory)
- Subfolder (subdirectory)
- File (text document, spreadsheet, picture, program, etc.)
- Root folder (direktory): base folder of the particular disk containing other subfolders.
- Parent folder: contains at least one subfolder.
Dontent of an opened folder
Displayed in the panel of Computer application. There are other subfolders and files.

- Disc C, D: hard disc.
- Disc F: external hard disc.
- Disc G: flash disc.

The size of files and folders
Sizes are given in byt (B).
- $1 \text{ kB} = 1024 \text{ B}$
- $1 \text{ MB} = 1024 \text{ kB}$
- $1 \text{ GB} = 1024 \text{ MB}$
- $1 \text{ TB} = 1024 \text{ GB}$

For example: to determine the capacity of removable disk, and cast his folders and files, then right-click the removable disk icon and in the floating menu
click on **Vlastnosti**.
Displayed window with capacity of G disk.
2.2.2 Files and folders

Folder Computer

The window Computer is displayed.
This window also can bee open if we double click on dosktop on icon

**How to create a new folder**

Folders are created directly in a root folder of hard drive C or as subfolders in current folder.

Steps
- in the Computer application open a folder, where you want to create new subfolder,
- main menu: Soubor → Nový → Složka. In the panel a new folder is created,
- rename new folder and press Enter key. The changes made are projected into the tree structure in the left panel of application immediately.

**How to rename a new folder**

Steps1
- open folder,
- click on the folder again (it is not a double-click but two separated clicks), at the end of folder name a text cursor appears and start blinking,
- rewrite the folder name,
- press Enter key.

Steps2
- open folder,
- main menu: Soubor → Přejmenovat,
- rewrite the folder name,
- press Enter key.
Steps 3
- click on the folder by right mouse button,
- select the Přejmenovat item from the floating menu.
- rewrite the folder name,
- press Enter key.

How to delete a new folder
Steps
- open deleting folder,
  - press the Delete key,
  - or main menu: Soubor → Odstranit,
  - or click on the folder by right mouse button and select the Odstranit item from the floating menu.
- Then in the Delete Folder window confirm folder deleting.

Note: Deleted folder is deleted definitely in case of a floopy disc, but moved into the Recycle Bin, where it can be restored from, in case of a hard drive.

Folder size
For example: to determine the size of ICT folder, then right-click the ICT folder.
2.2.3 Work with files

File types

<table>
<thead>
<tr>
<th>Název položky</th>
<th>Datum změny</th>
<th>Typ</th>
<th>Velikost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Syllabus_5_CZ.pdf</td>
<td>4.5.2009 12:05</td>
<td>Adobe Acrobat Document</td>
<td>256 kB</td>
</tr>
<tr>
<td>Project1.exe</td>
<td>27.3.2006 11:26</td>
<td>Aplikace</td>
<td>361 kB</td>
</tr>
<tr>
<td>Obrazovka.bmp</td>
<td>7.4.2013 9:54</td>
<td>IrfanView BMP File</td>
<td>1 257 kB</td>
</tr>
<tr>
<td>Panorama01.jpg</td>
<td>16.9.1998 10:15</td>
<td>IrfanView JPG File</td>
<td>50 kB</td>
</tr>
<tr>
<td>Fig.1.png</td>
<td>29.3.2013 13:08</td>
<td>IrfanView PNG File</td>
<td>32 kB</td>
</tr>
<tr>
<td>IDENO1.xls</td>
<td>10.3.2013 15:29</td>
<td>List aplikace Microsoft Excel 97–2003</td>
<td>562 kB</td>
</tr>
<tr>
<td>Seznam.mdb</td>
<td>22.10.2012 8:34</td>
<td>Microsoft Access Database</td>
<td>188 kB</td>
</tr>
<tr>
<td>Prezentace1.pptx</td>
<td>7.4.2013 9:44</td>
<td>Prezentace aplikace Microsoft PowerPoint</td>
<td>32 kB</td>
</tr>
<tr>
<td>Wildlife.wmv</td>
<td>14.7.2009 6:52</td>
<td>Soubor ve formátu WMA či WMV</td>
<td>25 631 kB</td>
</tr>
<tr>
<td>Poznámky.txt</td>
<td>7.4.2013 9:55</td>
<td>Textový dokument</td>
<td>0 kB</td>
</tr>
<tr>
<td>T1-book.zip</td>
<td>4.3.2013 14:46</td>
<td>WinRAR ZIP archiv</td>
<td>353 kB</td>
</tr>
<tr>
<td>Sleep Away.mp3</td>
<td>14.7.2009 6:52</td>
<td>Zvuk ve formátu MP3</td>
<td>4730 kB</td>
</tr>
</tbody>
</table>
How to create a text document
Launch the Poznámkový blok application.

Step 1:
→

Step 2:

- Všechny programy
Write some text
We are writing to „infinite line“ and by pressing the Enter key we break current paragraph.
How to save the document

Main menu

Uložit Ctrl+S
In displayed tree structure select a folder where to save the document. Name the selected and opened folder is inserted into the field (if selected folder is a subfolder of current opened folder, then it is necessary to repeat the selection until requested folder is reached). Write a name for the file to be saved and click on the button Uložit. Program will automatically join an extension, that describes file as a text document, to the file name.

Note
- When saving (main menu: File → Save) the file repeatedly it will be saved automatically without opening the SaveAs dialog.
- For saving the document to a file with different name or to different folder, use main menu: File → SaveAs.
Sorting of files
In application Computer we click on Název položky.

Files are sorted alphabetically.
How to rename folder

Steps 1
Click on the folder by right mouse button.

- Name of the selected folder or file is highlighted in blue.
- Rewrite the folder name and press Enter key.

Steps 2
Open folder, click on the folder again (it is not a double-click but two separated clicks), at the end of folder name a text cursor appears and start blinking, rewrite the folder name, press Enter key.

2.2.4 How to move and copy objects
When moving an object we move it from original location to target one, copying an object will keep the object on the original location and create a copy on the target location. Following steps is very important because it is valid for any object in the Windows environment.

Steps
- select moving/copying object,
- specify, whether we want to move it or copy it,
- define a location where the object is to be moved/copied,
• perform a command **Paste**.

**How to select a file/folder**
Click on the file/folder.

**How to select a group of files/folders in a sequence**
Click on the first file/folder and together with pressed Shift key click on the last one.
How to select a group of any files in a folder
Click on the first file and together with pressed Ctrl key click on other files.

<table>
<thead>
<tr>
<th>Název polečky</th>
<th>Datum změny</th>
<th>Typ</th>
<th>Velikost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fig1.png</td>
<td>29.3.2013 13:08</td>
<td>IrfanView PNG File</td>
<td>32 kB</td>
</tr>
<tr>
<td>IDEN01.xls</td>
<td>10.3.2013 15:29</td>
<td>List aplikace Microsoft Excel 97–2003</td>
<td>562 kB</td>
</tr>
<tr>
<td>INKOMTEL.doc</td>
<td>6.4.2013 18:53</td>
<td>Dokument aplikace Microsoft Word 97–2003</td>
<td>5 996 kB</td>
</tr>
<tr>
<td>Obrazovka.bmp</td>
<td>7.4.2013 9:54</td>
<td>IrfanView BMP File</td>
<td>1 267 kB</td>
</tr>
<tr>
<td>Panorama01.jpg</td>
<td>16.9.1998 10:16</td>
<td>IrfanView JPG File</td>
<td>60 kB</td>
</tr>
<tr>
<td>Poznámky.txt</td>
<td>7.4.2013 9:55</td>
<td>Textový dokument</td>
<td>0 kB</td>
</tr>
<tr>
<td>Prezentace1.pptx</td>
<td>7.4.2013 9:44</td>
<td>Prezentace aplikace Microsoft PowerPoint</td>
<td>32 kB</td>
</tr>
<tr>
<td>Project.exe</td>
<td>27.3.2006 11:26</td>
<td>Aplikace</td>
<td>361 kB</td>
</tr>
<tr>
<td>Seznam.mdb</td>
<td>22.10.2012 8:34</td>
<td>Microsoft Access Database</td>
<td>188 kB</td>
</tr>
<tr>
<td>Sleep Away.mp3</td>
<td>14.7.2009 6:52</td>
<td>Zvuk ve formátu MP3</td>
<td>4 730 kB</td>
</tr>
<tr>
<td>Syllabus_5_CZ.pdf</td>
<td>4.5.2009 12:05</td>
<td>Adobe Acrobat Document</td>
<td>256 kB</td>
</tr>
<tr>
<td>T1-book.zip</td>
<td>4.3.2013 14:46</td>
<td>WinRAR ZIP archiv</td>
<td>353 kB</td>
</tr>
<tr>
<td>Ukázkový textový s..</td>
<td>7.4.2013 10:56</td>
<td>Textový dokument</td>
<td>1 kB</td>
</tr>
<tr>
<td>Wildlife.wmv</td>
<td>14.7.2009 6:52</td>
<td>Soubor ve formátu WMA či WMV</td>
<td>25 631 kB</td>
</tr>
</tbody>
</table>

How to copy files in the Computer

Copying via menu
- select copied file,
- main menu: Edit → Copy,
- open target folder,
- main menu: Edit → Paste.

Copying via hot keys
- select copied file,
- press Ctrl + C keys,
- open target folder,
- press Ctrl + V keys.

Copying via buttons on the tool panel
- select copied file,
- click on the Copy button,
- open target folder,
- click on the Paste button.

Copying via mouse – step1
- in the left panel of the Computer open the original folder,
- in the right panel of the Computer select a file to copy,
- point at the copied file, press the left mouse button and together with the Ctrl key pressed move the file to the target folder in the panel of the Computer,
- as soon as the name of target folder is highlighted release the mouse button.

Copying via mouse – step2
- in the left panel of the Computer open the original folder,
- in the right panel of the Computer select a file to copy and click on with right button,
- in displayed window
How to move files in the Computer

Moving via menu
- select moved file,
- main menu: Edit → Cut,
- open target folder,
- main menu: Edit → Paste.

Moving via hot keys
- select moved file,
- press Ctrl + X keys,
• open target folder,
• press Ctrl + V keys.

**Moving via buttons on the tool panel**
• select moved file,
• click on the Cut button,
• open target folder,
• click on the Paste button.

**Moving via mouse – step1**
• in the left panel of the Computer open the original folder,
• in the right panel of the Computer select a file to move,
• point at the moving file, press the left mouse button and together with the Ctrl key pressed move the file to the target folder in the panel of the Computer,
• as soon as the name of target folder is highlighted release the mouse button.

**Moving via mouse – step2**
• in the panel of the Computer open the original folder,
• in the panel of the Computer select a file to move and click on with right button,
• in displayed window

- click on
- open target folder,
• in displayed window
How to move and copy folders in the Computer

The steps are analogous to the steps for moving and copying files. In this case select folders (by clicking on their name). During moving and copying folders their content including subfolders and all files in the folder is moved or copied as well.

2.2.5 Deleting and restoration

Steps for deleting files and folders

- select the file or folder you want to delete,
- right-click,
- in float menu click on Odstranit.
• in displayed window click on button [Ano].

Selected file or folder is moved in waste bin.

**Restoration of file from waste bin**

On desktop we click on icon [Koš]. In the list of files and folders you select an
element that we want to restore and click on Obnovit tuto položku.

File or folder is moved from waste bin to original folder.

Emptying of waste bin

In desktop click on icon → Vysypat koš. In displayed window click on

Ano
2.2.6 How to search for files and folders

Steps

• write name of searched file or folder

• press Enter key.

A star instead of file name
Find all files with specified type.

A star instead of a part of the file name
Find all files of specifies type theirs name contains specified text.

A star instead of file extension
Find all files with specified name.
2.3 Assistance programs

2.3.1 File compression

First select the file you want to compress.

Then right-click on selected file. In floating menu we click on

In the window, you can watch the process of compression.
Compressed file is stored in the original folder.

**Extracting compressed files and folders**

First select the file you want to extract.

Then right-click on selected file. In floating menu we click on Extractovat do INKOMTE1\
In the window, you can watch the extraction process.

The result of extraction is new folder

In the folder is extracted file.
2.3.2 Antivirus program

Virus database updates

Next to Zabezpečení click on button .

**Umožňuje prohlížet nejnovější zprávy a řešit potíže.**
Centrum akcí zjistilo problémy, které byste měli zkontrolovat a případně vyřešit.

**Zabezpečení**

*Program Windows Defender potřebuje zkontrolovat počítač*
Pravidelné kontrolování počítače zlepšuje jeho zabezpečení.

**Údržba**

*Nastavit zálohování*
Soubory nejsou zálohovány.
Vypnout zprávy o programu Windows Zálohování

Pokud potíže, které se u vás vyskytnou, nejsou uvedeny v seznamu, zkuste následující možnosti:

**Poradce při potížích**
Vyhledat a opravit problémy

**Obnovení**
Obnovit počítač do dřívějšího stavu

Unpack the section Zabezpečení in which we can watch current status of virus protection on our computers. Antivirus programs are usually updated automatically. In addition, but we can perform the update manually using the items in the following dialog box.
Zabezpečení

Program Windows Defender potřebuje zkontrolovat počítač
Pravidelné kontrolování počítače zlepšuje jeho zabezpečení.

Síťová brána firewall
- Zapnuto
  Brána Windows Firewall poskytuje aktivní ochranu počítače.

Windows Update
- Zapnuto
  Jakmile budou aktualizace k dispozici, systém Windows je automaticky nainstaluje.

Antivirová ochrana
- Zapnuto
  Program ESET Endpoint Antivirus 5.0 hlásí, že byl aktualizován a hledání virů je zapnuto.

Ochrana proti spywarů a nežádoucímu softwaru
- Zapnuto
  Program Windows Defender i ESET Endpoint Antivirus 5.0 hlásí, že jsou zapnuty.
  Poznámka: Pokud je současně spuštěno více antisywarových programů, může se počítač zpomalit.

Nastavení zabezpečení Internetu
- OK
  Veškerá nastavení zabezpečení Internetu mají doporučenou úroveň.

Řízení uživatelských účtů
- Zapnuto
  Nástroj Řízení uživatelských účtů zobrazí upozornění, pokud se programy pokusí provést změny v počítači.

Architektura NAP (Network Access Protection)
- Zapnuto
  Architektura NAP (Network Access Protection) je aktivní.
  Co je architektura NAP (Network Access Protection)?

Windows Defender
- Zapnuto
  Program Windows Defender vyžaduje vaši pozornost v několika záležitostech.

Jak zjistím, jaké nastavení zabezpečení je pro můj počítač správné?
2.4 Print management

2.4.1 How to set different default printers

Changing the setting of default printer

In displayed window double-click on the requested printer, then click on the.

In the displayed window double-click on the requested printer, then click on the.
Installing a new printer

Choose the type of a newly installed printer.

From the menu of printers, select the specific printer.
2.4.2 How to print files from the Computer

Steps

- Check that the printer is on and there is a paper inserted into the printer.
- Main menu: ..., or by pressing the right button click on a file and in the displayed floating menu select the Print item.
- Set the parameters of the print job: e.g. printing into a file, amount of printed copies etc.
View a list of print jobs

- Ovládací panely
- Zařízení a tiskárny

or

Move cursor on printer icon.

Click on printer icon and after click on

Zobrazit aktuální tiskové úlohy

Displayed window with print jobs.
3 Word Processing

Objectives (ECDL Module 3)
Word Processing requires the candidate to demonstrate the ability to use a word processing application to create everyday letters and documents. The candidate shall be able to:

- Work with documents and save them in different file formats.
- Choose built-in options such as the Help function to enhance productivity.
- Create and edit small-sized word processing documents that will be ready to share and distribute.
- Apply different formats to documents to enhance them before distribution and recognize good practice in choosing the appropriate formatting options.
- Insert tables, images and drawn objects into documents.
- Prepare documents for mail merge operations.
- Adjust document page settings and check and correct spelling before finally printing documents.

Time required
6 hours of basic studies and individually more time to practice.

The terms to remember

- work with file
- work with text
- text display
- page format
- font format
- paragraph format
- style
- tabs
- lists
- images
- objects
- tables
- hyphenation
- spell checker
- end of page
- headers and footers
- mail merge
- help
- templates
- print

3.1 The main use of Microsoft Word text editor
Writing a short text documents (letters, leaflets, invitations ...) after an extensive publications. You can insert into the text and objects that were created in other applications. E.g. tables or charts from Microsoft Excel.
3.1.1 Working with documents

Running Microsoft Word

Microsoft Word 2010

or

Microsoft Office

or on Desktop, double-click

Closing the document and a text editor

or

If the current version of the document has not been saved, follows a question to its saving.

Reopening of an existing document

Microsoft Word

Run Microsoft Word

or
In the dialog window choose folder, file → Otevřít.

Or Computer application run and double-click on the name of edited document.

**Opening a new document**

Run Microsoft Word → Souber → Nový → Prázdný dokument

**Create a new document based on a template (eg. Letter)**

Run Microsoft Word → Souber → Nový → select the template from the menu by clicking for example on Dopisy.
Saving the document

- **Save under the existing name to an existing folder, imposed previous document overrides the new version.**
- **Save under a new name or in any other format, or to another folder.**
In displayed window select the folder, write file name.

Type of file select from menu.

After click on button Uložit.
3.1.2 Improve work efficiency

Setting the name of the author of the document

Setting the default folder for opening and saving documents

In dialog window select folder.
Restriction on auto correct

In the next dialog window, you must reduce unwanted auto corrections.
Automatic insertion of solid space after one-character prepositions

In the next dialog window, enter the required adjustments.
Work with the help

or click on F1 key.
In edit box of the next dialog box, enter the text to which we look for help, for example „záhlaví“.

After click on button "Hledat".
Výsledky hledání pro frázi zápatí

- Přidání nebo odebrání záhlaví, zápatí a čísel stránek
  Článek
- Vložení nebo odstranění konce oddílu
  Článek
- Odebrání skrytých dat a osobních údajů kontrolované dokumentace
  Článek
- Rozdíly mezi formátu OpenDocument Text (ODT) a formátu Word
  Článek
- Klávesové zkratky pro aplikaci Microsoft Word
  Článek
- Novinky v aplikaci Word 2010
  Článek
- Vytvoření dokumentu
Viewing a document in the selected scale

Viewing a document in a format suitable for printing

Views rulers

View two documents side by side
3.2 Creating a text document

3.2.1 Entering text

Viewing a document on the screen

On the tab [Zobrazení] click on selected icon,
or in status bar click on selected icon.

Switching between different zoom of page views

On the tab [Zobrazení] click on selected icon,
or in the status bar move the slider on the zoom level.

Writing text

- Writing in the „endless line“ (the text is automatically separate in rows).
- Switching between insert and overwriting regime with Insert key.
- At the end of paragraph, press the enter key.

Inserting symbols and special characters

select from the last inserted symbols, for example arrow.
In dialog window on the tab select symbol and click on the button.
Inserting mathematical expressions
In writing equations proceed by clicking the appropriate tool.

3.2.2 Selecting and editing

Viewing and hide non-printing formatting marks

Selecting the word, line, sentence, paragraph, the entire contents of the document

- **Word**: double click on word.
- **Line**: click to the left of the selected line.
- **Paragraph**: double click to the left to the selected paragraph.
• **Document**: press key Ctrl+A.

**Deleting text**
- Delete key: deletes the character to the right of the cursor.
- BackSpace: deletes the character to the left of the cursor.

**Inserting text**
Move cursor in text and write new text.

**Search for words in the document**

```
Domů → Найти (or Ctrl+F) →
```

In edit box enter the search text.

**Replacement of words in the document**

```
Domů → Найти и заменить (or Ctrl+H) → in the edit box, enter the text you want to replace and then type the new text.
```

The click on one of these buttons.
Copying text

Select the copied text → . Place the cursor to where you want to copy the selected text → .

Or: Select the copied text, click the right mouse button. From the floating menu, select.

Place the cursor to where you want to copy the selected text → .

Or: select text → Ctrl+C → move cursor → Ctrl+V.

Moving text

Select text → . Place the cursor to where you want to copy the selected text → .
Or: Select the moved text, click the right mouse button. From the floating menu, select.

Place the cursor to where you want to copy the selected text →
Or: select text → Ctrl+X → move cursor → Ctrl+V.

Deleting text
Select text and press Delete key.

Cancellation of actions
Click on icon.

Restoring the cancellation actions
Click on icon.
3.3 Formatting text

3.3.1 Text

Changes text formatting is performed on the tab.

Font

In edit field, write name of new font.
Or: click on black arrow and in floating menu select font.
Font size

In edit field 12 write size.

Or: click on black arrow 12 and in floating menu select size.

Or: click on icon \( \text{A}^+ \) (Ctrl+?) – increase font.

Or: click on icon \( \text{A}^- \) (Ctrl+;) – decrease font.
Font style

Bold: ☑ (Ctrl+B).
Italic: ☑ (Ctrl+I).
Underline: ☑ (Ctrl+U). Or: click on black arrow ☑ and in floating menu select style of underline.

Index

Lower index: ☑ (Ctrl+=).
Top index: ☑ (Ctrl+%).

Color of text

Click on icon ☑ specify the default font color. Click on black arrow ☑ and in window select color.
Or click on button ![Button](image) and in window select color.

Or on the tab ![Tab](image) we define new color.
**Color of background**

Click on icon to specify the default background color. Click on black arrow and in window select background color.

**Dialog window Písmo**

Click on black arrow in group icons. In dialog window select font parameters.
Automatic hyphenation

3.3.2 Paragraph

Clic on tab Domů.

End of paragraph

Place cursor on end of paragraph and press tab Enter.

Text alignment

- zarovnání doleva (Ctrl+L),
- align center (Ctrl+E),
- align right (Ctrl+R),
- block alignment (Ctrl+J).

Indent left and right

Set breakpoints in the shape of a triangle on the left and on the right edge of the ruler.

Click ond black arrow in group icons Odstavec.
In dialog window select paragraph parameters.

**Tab stops**

The choice of the type tab stops: repeatedly pressing the left of the horizontal ruler, select the type of tab stops:

- [ ] - left tab,
- [ ] - center tab,
- [ ] - right tab,
- [ ] - decimal tab,
- [ ] - bar tab,
- [ ] - first line indent,
- [ ] - hanging indent.
Set tab stops

On the tab \textbullet \rightarrow \rightarrow \checkmark \text{Pravítko}. When you select the type of tab stop click the mouse to the position of the horizontal ruler.

Shift or removal of the tab stop: drag the tab stop outside the ruler.
Moving the cursor on tab stops: left – press Tab keys; right – press Shift+Tab keys.

Bullets

- Inserting bullets: \textbullet \rightarrow \rightarrow select type of bullets.
- Select type of bullets: click on black arrow in icon \textbullet. In floating menu select type.

- Define new bullets: click on button \textbullet. In window click on tab Symbol….
In window click on selected icon, for example ☑, and click on OK.
Paragraph numbering

- Inserting numbering: select type of numbering.
- Select type of numbering: click on black arrow in icon. In floating menu select type.

For example click on icon.
- Define new numbering: click on button Definovat nový číselný formát... In window select format of numbering and click button OK.
The frame around a paragraph

in window select format of frame.

Shading
Select paragraph → select color.

3.4 Objects
3.4.1 Tables
Creating of tables

The number of rows and columns the generated table mark in the window with the mouse while holding the left button and move the mouse
or click on \textit{Vložit tabulku...}. In displayed window we define the number of rows and columns.

**Addition row an column to the table**

**Addition row:** place the cursor to the desired location to the table →

**Addition column:** place the cursor to the desired location to the table →

**Elimination of row or column**

**Elimination of row:** place the cursor in the table on the row you want to cancel →
Elimination of column: place the cursor in the table on the column you want to cancel.

Elimination a table: place the cursor in the table and click on icon from group Odstranit tabulku.

3.4.2 Formatting of tables

Changing the height of the row and column width of the table

On the tab Nástroje tabulky click on icon from group Velikost buňky

or klick on blacek arrow in icon Velikost buňky. We define parameters of table.
### Vlastnosti tabulky

<table>
<thead>
<tr>
<th>Tabulka</th>
<th>Řádek</th>
<th>Sloupec</th>
<th>Buňka</th>
<th>Alternativní text</th>
</tr>
</thead>
</table>

**Velikost**
- Jednotně vybraná šířka: 
  - Měrná jednotka: Centimetry

**Zarovnání**
- Řádek
- Sloupec
- Buňka

**Odstavení řeza**
- 1,14 cm

**Obtekání textu**
- Žádné
- Oplot

**Obraničení a stínování**
- Možnosti...
Cell borders

On the tab select

- pen style from menu
- pen width from menu

- pen color
- method of cell border from menu
3.4.3 Graphic objects

Inserting objects

First place cursor in the text where you want to insert the object. On the tab select inserting object.

Inserting an image

On the tab → select the folder and image file.

Inserting an clipart

On the tab → select the folder and clipart.
Insert shapes: from menu select shapes.
**Insert image SmartArt:**

1. From menu select image.

**Insert graph:**

1. Continue creating graphs using MS Excel spreadsheet.
Changing the size and location of the object

Using the mouse: click on the object and move the boundary squares, or the whole picture.

Deleting object
Select object and press Delete key.

3.5 Mail merge

All activities are performed through the tab "Korespondence".

3.5.1 Preparation

The creation of form letters

Opening a document for mail merge
Základním dokumentem může být libovolný dokument, ve kterém budeme zvolené texty nahrazovat údaje z databáze, např. jména, příjmení a adresy příjemců dopisů.
Creating a new database of recipients of letters

Korespendence → Vybrat příjemce → Zadat nový seznam...

Vlastní nastavení sloupčů...
In dialog window change field names according to our requirements, for example:
Select folder for saving new database and click on button **Uložit**.
Open an existing database of recipients of letters

Select folder, database file an click on button

Otevřít
To change the content database

Korespondence ➔ Upravit seznam příjemců

![Diagram of the content database](image)

-> Adresy.mdb ➔ Upravit...
Insert data to database and click on button →

Microsoft Word

Chcete aktualizovat seznam příjemců a uložit tyto změny do souboru Adresy.mdb?

Ano  Ne  Storno

Ano →
Insert merge fields

The main document put links to the fields from the database.
Place the cursor to the main document to the place where it is to be added the statement from the database.
Instead of the original word Pna is inserted merge fields. Repeat for other fields.

```
«Titul»
«Jméno» «Příjmení»
«Ulice»
«PSČ» «Město»
«Oslovení»
```
dovolte mi, abych se na Vás obrátil s následující žádostí...

### 3.5.2 Outputs

Merge data with the document

We can specify the requirements for merging the document only with selected records from the database. The merger is beneficial to carry out in the document, and only one
All generated letters now make up a new document.

**Print the results of the merge**

![Print dialog box](image)

3.6 **Preparation of printouts**

3.6.1 **Setting**

**Document orientation**

![Document orientation settings](image)
or

Paper format

→ we select for example:
### The document margins

<table>
<thead>
<tr>
<th>Type</th>
<th>Margins</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normální</td>
<td>Nahore: 2,5 cm</td>
</tr>
<tr>
<td></td>
<td>Dole: 2,5 cm</td>
</tr>
<tr>
<td></td>
<td>Vlevo: 2,5 cm</td>
</tr>
<tr>
<td></td>
<td>Vpravo: 2,5 cm</td>
</tr>
<tr>
<td>Úzké</td>
<td>Nahore: 1,27 cm</td>
</tr>
<tr>
<td></td>
<td>Dole: 1,27 cm</td>
</tr>
<tr>
<td></td>
<td>Vlevo: 1,27 cm</td>
</tr>
<tr>
<td></td>
<td>Vpravo: 1,27 cm</td>
</tr>
<tr>
<td>Střední</td>
<td>Nahore: 2,54 cm</td>
</tr>
<tr>
<td></td>
<td>Dole: 2,54 cm</td>
</tr>
<tr>
<td></td>
<td>Vlevo: 1,91 cm</td>
</tr>
<tr>
<td></td>
<td>Vpravo: 1,91 cm</td>
</tr>
<tr>
<td>Široké</td>
<td>Nahore: 2,54 cm</td>
</tr>
<tr>
<td></td>
<td>Dole: 2,54 cm</td>
</tr>
<tr>
<td></td>
<td>Vlevo: 5,08 cm</td>
</tr>
<tr>
<td></td>
<td>Vpravo: 5,08 cm</td>
</tr>
<tr>
<td>Zrcadlové</td>
<td>Nahore: 2,54 cm</td>
</tr>
<tr>
<td></td>
<td>Dole: 2,54 cm</td>
</tr>
<tr>
<td></td>
<td>Uvnitř: 3,18 cm</td>
</tr>
<tr>
<td></td>
<td>Vně: 2,54 cm</td>
</tr>
</tbody>
</table>

Vlastní okraje...
or

- 

specify the dimensions of the margins.

End of page

In document is inserted symbol

**Headers and footers**

**Insert header:**
Insert footer:  

Opening header / footer: double click on header / footer.  

Insert and modify text: standard input text.  

Insert page number:
Insert date and time:

Insert file name:

Insert file name in header / footer:
Closing header / footer:

3.6.2 Revision and print

Spell check
Informační a komunikační

Prerekvizity: předmět nemá prerekvizity, ale je prerekvizitou pro předmět Informační a komunikační technologie 2.

Přidat do slovníku.
Previewing a document before printing

Current page is displayed.

Print

- number of copies: 
  - Kopie: 1

- print range: 

  - Tisknout všechny stránky
    - Vytiskne celý dokument.
  
  - Tisknout výběr
    - Vytiskne pouze vybraný obsah.
  
  - Tisknout aktuální stránku
    - Vytiskne pouze aktuální stránku.
  
  - Tisknout vlastní rozsah
    - Zadat konkrétní stránky nebo oddíly pro tisk

  - or

  - Tisknout aktuální stránku
    - Vytiskne pouze aktuální stránku.
• or

Dokument

Tisknout všechny stránky
Vytiskne celý dokument.

Tisknout výběr
Vytiskne pouze vybraný obsah.

Tisknout aktuální stránku
Vytiskne pouze aktuální stránku.

Tisknout vlastní rozsah
Zadat konkrétí stránky nebo oddíly pro tisk

Stránky: 1-5
4 Web Browsing and Communication

Objectives (ECDL Module 7)
Web Browsing and Communication is divided into two sections.

The first section, Web Browsing, requires the candidate to know about the Internet and to use a web browsing application. The candidate shall be able to:
- Understand what the Internet is and common terms associated with it. Be aware of some security considerations when using the Internet.
- Accomplish everyday web browsing tasks including changing browser settings.
- Search for information and complete and submit web-based forms.
- Save web pages and download files from the web. Copy web content into a document.

The second section, Communication, requires the candidate to understand some of the concepts of electronic mail (e-mail) and know about other communication options. The candidate shall be able to:
- Understand what e-mail is and know some advantages and disadvantages of its use. Be aware of other communication options.
- Be aware of network etiquette and security considerations when using e-mail.
- Create, spell check and send e-mail. Reply to and forward e-mail, handle file attachments and print an e-mail.
- Be aware of ways to enhance productivity when working with e-mail software. Organize and manage e-mail.

Time required
2 hours of basic studies and individually more time to practice.

The terms to remember
- internet
- www
- internet address
- hypertext
- computer viruses
- firewall
- internet search
- e-mail
- SMS
- VoIP
- a-mail attachment
- phishing
- virtual community
- electronic signature
- distribution lists
4.1 Internet

4.1.1 Basic concepts

Internet
Worldwide system of computer networks.

World Wide Web (WWW)
One of the many Internet service.

Internet address
For example: http://www.uhk.cz/cs-cz/Stranky/default.aspx
- http – protocol,
- www – server,
- uhk – domain of the second order,
- cz – generic domain
- cs-cz/Stranky/default.aspx – location specific pages on a server.

Web browser
Google Chrome, Internet Explorer, Maxthon, Mozilla Firefox, Nescape Navigator, Opera, Safari.

Web search
An application that based on the specified keyword searches on the Internet pages that contain the information sought.

Information channels
Really Simple Syndication feed (RSS): after logging to a selected channel, the user gets the option of regular downloading of information from the channel.

Downloading files from the Internet
Podcast: service for publishing and automatic downloading of audio and video clips from the Internet.

4.1.2 Safety aspects

Safety website
https – encrypted data transmission using HTTP protocol.

Digital certificate web site
The encryption key, that defines how data encryption.

Encryption
Storing data in a code, which is not readable in a standard manner.

Dangerous programs
Computer viruses
Computer worms
Trojan horses
Spyware
Malware

The antivirus program
A program that is used to detect viruses.

Firewall
Applications that are separated by two computer networks.

Secure access to computer networks
Insert username and password.

Risks arising from internet
Deliberate elicitation of personal information, bullying, harassment, targeting the attackers on Internet users.

4.2 Web browser Internet Explorer

4.2.1 Basic viewing

Run the Internet Explorer
Click on icon

or click on icon

Ending Internet Explorer
Click on button

View website
In the address panel, enter the URL of the page, and then press Enter.

Panel of addresses
http://www.google.cz/ uses for entry and search web page addresses.

Find
View
Refresh
Updating the content of the website
Right-click on the page whose contents you want to update, and in the menu click on "Aktualizovat".

The icons in the toolbar

**Back**: a return to previous pages.

**Forward**: after the previous press icon **`,** return to original page.

**Home (Alt+Home)**: return to the homepage.

**Favorites (Alt+C)**: displays a list of addresses of favorite pages.

**Tools (Alt+X)**: shows the tools menu.
Work with help
Press F1 key.

4.2.2 Setting

Setting your home page
Create internet page, click on icon ☀, click on

Možnosti Internetu

In window on the tab click on button Použít aktuální.
4.2.3 Navigation

The use of hyperlink

When you click on the hyperlink, then displays the new webpage.

Movement between the visited websites

Click on icon ← or →.

Go to the homepage

Click on the icon in the shape of a house or press key Alt+Home.
4.3 Working with the Internet

4.3.1 Forms

Filling out online forms

For example IDOS.

Bookmark

Hyperlink

Text field

Check box
4.3.2 Searching

Choosing an internet search
- Google: http://www.google.cz/
- Seznam: http://www.seznam.cz/
- Yahoo: http://www.yahoo.com/
- Altavista: http://www.altavista.com/

Finding desired information
Int the text box inter the search text.

Internet encyclopedia
For example:
4.4 Outputs from the Internet

4.4.1 Saving files

Save a web page as a file on disk

![Image of save button]

Soubor

Uložit jako... Ctrl+S
4.4.2 Preparation and printing

Preparing a website to print

In displayed window define parameter for print.
4.5 *Elektronic kommunication*

4.5.1 Basic concepts

**E-mail**

Electronic mail is the sending of files via computer networks between the sender's and recipient of the mail.

**E-mail address**

The address consists of two parts which are connected with @. Before the @ is given concrete designation of the owner of address. After @ is the address of the institution. For example: [jmeno.prijmeni@uhk.cz](mailto:jmeno.prijmeni@uhk.cz) In the address may be used only English letters, digits and a dot.

**Short Message Servise (SMS)**

**Voice over Internet Protocol (VoIP)**

Internet telephony.
Instant Messaging (IM)
Real-time communication.

Online (virtual) community
Websites of interest groups, Internet forums, chat rooms, online games players association, etc.

4.5.2 Safety aspects

Spam and phishing messages
Exists a danger adoption of spam or phishing messages. Therefore, it is necessary to pass your address only to trusted persons or institutions.

Phishing
Fraudulent technique electronic communications. Its purpose is to obtain sensitive information addressee.

The spread of viruses
Suspicious messages should be removed immediately.

Elektronic (digital) signature
Officially registered code of user for electronic communications which the sender connects to the electronic message for the confirmation of his identity.

4.5.3 Theory

Benefits of communication by e-mail
The speed of information transfer and low financial cost.

Etiquette working with e-mail
In the field enter them always brief and accurate name that identifies the outgoing message. On the received messages always clearly and concisely answer. Messages sent without grammatical errors.

Problems with sending e-mail attachments
Limit the size of files that are sent as a e-mail attachment.
The spread of viruses.

The addresseees of e-mail
To: address of the recipient of a message.
Copy: address of the recipient copy of the message.
Hidden address: address of the recipient copy of the message can also enter covertly so that it does not see the other recipients of the message.

In all the above cases, it may not be always only one addressee, but in the appropriate input box can be written addresses more recipients of a message.
4.6 Using e-mail

4.6.1 Sending a new message

Running Outlook

Double click on icon or click on icon →

or click on icon →

Termination of work with e-mail

Click on button

Create a new message

- click the pull-down menu, 
- a dialog box appears, enter items,

- Komu: address of the recipient of a message (e.g.: Josef.Novak@firmaxy.cz),
- Kopie: address of the recipient copy of the report (may be not completed),
- Předmět: the name of the message,
- to the next window, write text of messages.

Insert an attachment to a message

On the toolbar, click on the button .

In the dialog box, enter the full path to the attachments, ie. enter the folder name and file name.
Click on the button "Vložit".
Subsequently, the same way we can choose other attachments.

Delete attachments from messages
If we accidentally connect any attachment, which we do not want send to the recipient of the message, then the message is deleted so that her first mark by clicking on the its name, for example "Časy 2003 05 19.xls", and then press Delete key.

Saving unfinished message
In dialog window we select the folder and click on the button  OK .

Check spelling
Before sending a message, we will check spelling.  Revize  →  ABC  

If the text without errors, then a window appears with information about successfully checking.
If the text contains an error, then a window is displayed with the indicated error and suggestions for possible solutions.

**Setting parameters of message**

Before sending the message, can be set parameters of message using the following procedures. Parameters determine primarily by the importance of message and its processing time.
In the displayed dialog box, set the parameters of message.

Sending of message

Click on the button.

4.6.2 Reading the message

Meaning of icons for messages

- unreaded message.
- readed message.
- message which we have already answered or we sent it away.
- message with supplement.

Opening an e-mail

Click on 💌 Doručená pošta [1]. In a message list, you find the one you want to open. Clicking on the a title will display text message in a separate browser window as a preview e-mail message. Double-click on the a title to open the message in a new window.
Reading of attachment

We open attachments by clicking on their names. Automatically opens the appropriate application, which displays the attachment. After reading of the attachment we close the application, and so we come back to the browser e-mail.

Closing of e-mail

Click on the button.

Creating answer on message

- answer the sender of the message, the attachments is not sended back.

- or – the answer sender of all recipients message, the attachments is not sended back.

- Automatically are filled items and

- In the window is the text of the original message to which we reply. Everything can be edited. The answer may or may not contain the text of the original message.

Předání zprávy dalšímu adresátovi

- it is necessary to enter the address of the new recipients of the message, the attachments are sent away automatically.

Save attachments

By right-click on the the attachment name will display a floating menu in which to select the next procedure.
Printing of message

On the tools panel click on \textbf{Soubor} \rightarrow \textbf{Tisk}.

Automatically displays a preview of message before printing. If we are satisfied with the preview, click on icon \textbf{Obnovit}.

If we want to change the way the print then click on \textbf{Možnosti tisku}. In the displayed window make the appropriate changes before printing. Then click on the button \textbf{Tisk}.

4.6.3 Improving the efficiency of work

Add and remove fields displayed in the incoming message list

Right-click on the the item that defines how the ordering of messages

\begin{itemize}
  \item \textbf{Uspořádat podle: Datum \ Nejnovější nahoře}
  \item \textbf{Sloupce...}
\end{itemize}

In the dialog box, you can set items that will be displayed by each of messages in the incoming message list.
Reply to a message with or without the original message

You can edit the original and new text in messages.

Designation read and unread messages

On the tab **Domů** click on the icon ![Nepřečtené či přečtené](image).

Toolbars

Right-click on the ribbon and in displayed floating menu, click the unchecked item **Minimalizovat pás karet**. Leaving only the names of the tabs.

To return the original full view, then in the floating menu, click on the checked item **Minimalizovat pás karet**.

Help

Press key F1.

4.7 Management of e-mails

4.7.1 Organizations

Search of messages

Open the message folder and in box [Prohledat: Doručená pošta (Ctrl-E)] enter the text you want to search. After you press Enter.
Sorting messages

Messages can sort by sender, subject, date, etc.., Open the folder with the message and click on the button. In the floating menu that appears, select the sort order of messages.

To reverse the sort order of messages, then in the tab click on the button.

Folders do store messages

Messages are automatically saved to the basic components
- Inbox
- Drafts
- Sent mail
- Deleted mail

In addition to the standard folders can create your own user folder and in them store the archived messages.

Creating a folder

On the tab click on the icon .

In the dialog box, enter the new folder name, its location within the folder tree, and then click on the button.
Deleting folder

Click on the folder you want to delete and press the Delete key.

Moving messages

Moving messages between folders.

- **Move using the mouse**: the mouse pointer will show the moving messages, press and let the left mouse button, move the mouse pointer over the destination folder and release the mouse button.

- **Move using keys**: Moving messages denoted by clicking on its name, enter the keyboard shortcut Ctrl + X, move the cursor to the destination folder and enter the keyboard shortcut Ctrl + V.

Deleting messages

Click on the message you want to delete. Ont the tab click on or press Delete key. The message is moved to the folder Deleted mail.

Recovering deleted messages

In the folder select message. On the tab click on . In displayed window mark the destination folder for recovering messages and click on the button.
The definitive removal of deleted messages

Open the folder [Odstraněná pošta (1)]. Click on the name of the message. On the tab [Odstranit] clock on the icon [X] or press Delete key.

In the dialog box click on the button [Ano].
## 5 Dictionary of important terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Translation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Antivirus program</td>
<td>Antivirový program</td>
</tr>
<tr>
<td>Application system</td>
<td>Aplikační systém</td>
</tr>
<tr>
<td>CD: Compact Disc</td>
<td>Kompaktní disk</td>
</tr>
<tr>
<td>CD-R: Compact Disc – Recordable</td>
<td>Kompaktní disk s možností jednorázového zápisu dat</td>
</tr>
<tr>
<td>CD-RW: Compact Disc – ReWritable</td>
<td>Kompaktní disk s možností opakovaného zápisu dat</td>
</tr>
<tr>
<td>Component</td>
<td>Složka</td>
</tr>
<tr>
<td>Compression</td>
<td>Komprese</td>
</tr>
<tr>
<td>Computer networks</td>
<td>Počítačové sítě</td>
</tr>
<tr>
<td>Computer virus</td>
<td>Počítačový virus</td>
</tr>
<tr>
<td>CPU: Central Processing Unit</td>
<td>Procesor počítače</td>
</tr>
<tr>
<td>Data protection</td>
<td>Ochrana dat</td>
</tr>
<tr>
<td>Desktop</td>
<td>Pracovní plocha počítače</td>
</tr>
<tr>
<td>Distribution lists</td>
<td>Distribuční seznamy</td>
</tr>
<tr>
<td>DVD: Digital Versatile Disc; Digital Video Disc</td>
<td>Digitální univerzální disk; digitální video disk</td>
</tr>
<tr>
<td>DVD-R: Digital Versatile Disc – Recordable</td>
<td>Digitální univerzální disk s možností jednorázového zápisu dat</td>
</tr>
<tr>
<td>DVD-RW: Digital Versatile Disc – ReWritable</td>
<td>Digitální univerzální disk s možností opakovaného zápisu dat</td>
</tr>
<tr>
<td>ECDL: European Computer Driving Licence</td>
<td>Evropský řidičský průkaz na počítač</td>
</tr>
<tr>
<td>Electronic signature</td>
<td>Elektronický podpis</td>
</tr>
<tr>
<td>Encryption</td>
<td>Šifrování</td>
</tr>
<tr>
<td>End of page</td>
<td>Konec stránky</td>
</tr>
<tr>
<td>e-learning</td>
<td>e-learning – výuka pomocí počítačů</td>
</tr>
<tr>
<td>e-mail attachments</td>
<td>Přílohy elektronické pošty</td>
</tr>
<tr>
<td>Extraction</td>
<td>Extrakce</td>
</tr>
<tr>
<td>File</td>
<td>Soubor</td>
</tr>
<tr>
<td>File attribute</td>
<td>Atribut souboru</td>
</tr>
<tr>
<td>Firewall</td>
<td>Ochrana proti nežádoucím souborům</td>
</tr>
<tr>
<td>Font format</td>
<td>Formát písma</td>
</tr>
<tr>
<td>Footers</td>
<td>Zápatí stránky</td>
</tr>
<tr>
<td>GUI: Graphical User Interface</td>
<td>Grafické uživatelské prostředí</td>
</tr>
<tr>
<td>Hardware</td>
<td>Hardwer – pevné části počítače</td>
</tr>
<tr>
<td>Headers</td>
<td>Záhlaví stránky</td>
</tr>
<tr>
<td>Health</td>
<td>Ochrana zdraví</td>
</tr>
<tr>
<td>Help</td>
<td>Nápověda</td>
</tr>
<tr>
<td>Https</td>
<td>Šifrovaný přenos dat s HTTP protokolem</td>
</tr>
<tr>
<td>Hyperlink</td>
<td>Hypertextový odkaz</td>
</tr>
<tr>
<td>Hypernation</td>
<td>Dělení slov</td>
</tr>
<tr>
<td>English</td>
<td>Czech</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>Hypertext</td>
<td>Nelineární text propojený hypertextovými odkazy</td>
</tr>
<tr>
<td>Icons</td>
<td>Ikony</td>
</tr>
<tr>
<td>ICT: Information and Communication Technologies</td>
<td>Informační a komunikační technologie</td>
</tr>
<tr>
<td>Images</td>
<td>Obrázky</td>
</tr>
<tr>
<td>IM: Instant Messaging</td>
<td>Komunikace v reálném čase</td>
</tr>
<tr>
<td>Input devices</td>
<td>Vstupní zřízení</td>
</tr>
<tr>
<td>Installing the printer</td>
<td>Instalace tiskárny</td>
</tr>
<tr>
<td>Internet</td>
<td>Internet – celosvětová počítačová síť</td>
</tr>
<tr>
<td>Internet search</td>
<td>Internetový vyhledávač</td>
</tr>
<tr>
<td>ISP: Internet Service Provider</td>
<td>Poskytovatel internetového připojení</td>
</tr>
<tr>
<td>LAN: Local Area Network</td>
<td>Místní počítačová síť</td>
</tr>
<tr>
<td>Lists</td>
<td>Seznamy</td>
</tr>
<tr>
<td>Mail merge</td>
<td>Hromadná korespondence</td>
</tr>
<tr>
<td>Malware</td>
<td>Program, který způsobuje škody v počítači</td>
</tr>
<tr>
<td>Memory</td>
<td>Paměť</td>
</tr>
<tr>
<td>MOODLE: Modular Object-Oriented Dynamic Learning Environment</td>
<td>Modulární objektově orientované dynamické prostředí pro výuku</td>
</tr>
<tr>
<td>MS: Microsoft</td>
<td>Microsoft</td>
</tr>
<tr>
<td>MS DOS: Microsoft Disc Operating System</td>
<td>Diskový operační systém firmy Microsoft</td>
</tr>
<tr>
<td>Objects</td>
<td>Objekty</td>
</tr>
<tr>
<td>Operating system</td>
<td>Operační systém</td>
</tr>
<tr>
<td>Output devices</td>
<td>Výstupní zařízení</td>
</tr>
<tr>
<td>Page size</td>
<td>Velikost stránky</td>
</tr>
<tr>
<td>Paragraph format</td>
<td>Formát odstavce</td>
</tr>
<tr>
<td>PC: Personal Computer</td>
<td>Osobní počítač</td>
</tr>
<tr>
<td>PDA: Personal Digital Assistant</td>
<td>Osobní digitální asistent</td>
</tr>
<tr>
<td>Personal data</td>
<td>Osobní údaje</td>
</tr>
<tr>
<td>Phishing</td>
<td>Nezákonné získávání osobních dat</td>
</tr>
<tr>
<td>Podcast</td>
<td>Služba pro zveřejňování a stahování zvukových nahrávek a videoklipů</td>
</tr>
<tr>
<td>Print</td>
<td>Tisk</td>
</tr>
<tr>
<td>Processor</td>
<td>Procesor</td>
</tr>
<tr>
<td>RAID: Redundant Array of Inexpensive/Independent Disks</td>
<td>Vícenásobné diskové pole laciných/nezávislých disků</td>
</tr>
<tr>
<td>RAM: Random Access Memory</td>
<td>Paměť pro čtení i zápis dat</td>
</tr>
<tr>
<td>ROM: Read Only Memory</td>
<td>Paměť pouze pro čtení dat</td>
</tr>
<tr>
<td>RSS: Really Simple Syndication feed</td>
<td>Formát pro čtení novinek na internetu</td>
</tr>
<tr>
<td>Software</td>
<td>Softwar – programové vybavení počítače</td>
</tr>
<tr>
<td>SMS: Short Message Service</td>
<td>Krátká textová zpráva</td>
</tr>
<tr>
<td>Spell checker</td>
<td>Kontrola pravopisu</td>
</tr>
<tr>
<td>Spyware</td>
<td>Programy pro vykrádání dat z počítače</td>
</tr>
<tr>
<td>Style</td>
<td>Styly</td>
</tr>
<tr>
<td>Table</td>
<td>Tabulky</td>
</tr>
<tr>
<td>Tabs</td>
<td>Tabulátory</td>
</tr>
<tr>
<td>Templates</td>
<td>Šablony</td>
</tr>
<tr>
<td>English</td>
<td>Czech</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>Text display</td>
<td>Zobrazení textu</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Panel nástrojů</td>
</tr>
<tr>
<td>Tree structure</td>
<td>Stromová struktura</td>
</tr>
<tr>
<td>URL: Uniform Resource Locator</td>
<td>Internetová adresa</td>
</tr>
<tr>
<td>USB: Universal Serial Bus</td>
<td>Univerzální port (konektor)</td>
</tr>
<tr>
<td>VDU: Video Display Unit</td>
<td>Monítor počítače</td>
</tr>
<tr>
<td>Virus databáze</td>
<td>Virová databáze</td>
</tr>
<tr>
<td>VoIP: Voice over Internet Protocol</td>
<td>Přenos hlasu prostřednictvím internetového protokolu</td>
</tr>
<tr>
<td>VPN: Virtual Private Network</td>
<td>Virtuální soukromá počítačová sít’</td>
</tr>
<tr>
<td>WAN: Wide Area Network</td>
<td>Rozsáhlá počítačová sít’</td>
</tr>
<tr>
<td>Waste bin</td>
<td>Koš</td>
</tr>
<tr>
<td>Window</td>
<td>Okno</td>
</tr>
<tr>
<td>WLAN: Wireless Local Area Network</td>
<td>Místní bezdrátová počítačová sít’</td>
</tr>
<tr>
<td>Work with text</td>
<td>Práce s textem</td>
</tr>
<tr>
<td>Work with the file</td>
<td>Práce se souborem</td>
</tr>
<tr>
<td>WWW: World Wide Web</td>
<td>Celosvětová sít’ – služba internetu</td>
</tr>
</tbody>
</table>
Literatura

ECDL testy